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1 Installation

ArAR is compatible with the JavaTM Platform, Standard Edition (SE) 7 and 8, and is distributed
as an executable Java ARchive (JAR) application. All resources necessary for running ArAR will
be self-extracted into the same directory as the ArAR JAR the first time the application is launched
(or if any resources go missing). These resources include: the ArAR preferences file; a README;
a directory with the four editable ArAR libraries (containing (1) 40K decay constants, (2) isotopic
abundance values, (3) common 40Ar/39Ar monitor mineral ages, and (4) 40Ar*/40K values for com-
mon monitor minerals); and a directory with the ArAR documentation (including this manual, a
Quick-Start Guide, and documents explaining ArAR Nomenclature and Calculations).

1.1 Downloading the Java Runtime Environment

The Java runtime environment (JRE) is freely available as part of the Java SE 7 and 8 releases,
which can be downloaded at http://www.oracle.com/technetwork/java/javase/
downloads/index.html. After downloading and running either the Java SE 7 or 8 installers,
you are ready to run ArAR. To check that you have the latest JRE installed, visit: https://www.
java.com/verify/.1

1.2 Downloading ArAR

ArAR is freely available to download at tectonics.asu.edu/downloads. Once ArAR

is downloaded, you may save it to the directory of your choice (there is no installer to run).

1Note: some computers may only have Java installed for web browsers. If the Java verification indicates you have
Java installed but ArAR doesn’t launch, try reinstalling the Java JRE.
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2 Starting and Exiting ArAR

ArAR may be launched either by double-clicking the executable JAR, or by opening a command-
line tool and navigating to the directory containing the ArAR JAR and running the command

java -jar ArAR.jar

at the prompt.
To exit ArAR, click the red ‘X’ button at the top of the ArAR window, select ‘Exit ArAR’ from

the ‘ArAR’ menu, or use the hotkey combination ‘Meta + Q’, where ‘Meta’ is the ‘Ctrl’
key on a Windows machine and the ‘Cmd’ key on a Macintosh.

3 Data Layout and Handling

ArAR relies on my JDataFrame object for importing, exporting, storing, and manipulating data.
Currently, JDataFrame, and hence, ArAR, can only read/write delimited text files that conform
to the JDataFrame layout guidelines (see The JDataFrame Layout); they cannot read/write Excel
worksheets2. ArAR can read/write the following file types: comma separated value files (*.csv),
tab-delimited text files (*.txt), space delimited text files (*.prn), and JDataFrame text files (*.jdf).
Should you desire to save or import text files where the data are delimited by the string ‘(= Smiles
=)’, then you can do so with JDataFrame text files by opening the ArAR preferences pane (see
Editing ArAR Preferences) and setting the JDataFrame import and export delimiters to ‘Custom’
and enter the string ‘(= Smiles =)’ in the appropriate fields. Note, custom delimiters must be alpha-
numeric, and can only include the following special characters: \ ! @ # $ % & ( ) [ ] { }. Tip:
don’t save or import a file where the contents of individual cells may include the delimiter (e.g., if
there are commas in a string of notes, don’t save the dataset to a .csv file).

3.1 The JDataFrame Layout

The JDataFrame object, and hence, ArAR, can read and write data to delimited files as long
as those data conform to the JDataFrame Layout. The JDataFrame Layout consists of six major
elements: (A) a ‘corner’ piece, (B) a set of alphanumeric column names, (C) a set of alphanumeric
row names, (D) an array of numeric data, (E) an array of alphanumeric notes, and (M) a header
containing (optional) metadata (Fig. 1). Only numeric data (located in element D) or notes (lo-
cated in element E) are required when preparing a delimited file for import into ArAR (i.e., into
a JDataFrame)3. All other elements are optional, though default information for A (the ‘corner’

2This functionality may be added to a future release, depending on popular demand, though the internal structure
of the Excel worksheets would still need to conform to the JDataFrame Layout.

3If you plan on performing any numeric computations with ArAR, be sure to import a file with at least one column
of numeric data, even though it’s possible to import a file filled with only alphanumeric notes.
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M1

M4

M2 M3

A B1 B2

C D E

Main Data
A – The ‘corner’ piece
B – Column names for (1) 
numeric data, and (2) notes
C – Row names
D – Numeric data
E – Notes

Metadata
M1 – ‘Begin MetaData’
M2 – Property names
M3 – Property descriptions
M4 – ‘End MetaData’

Figure 1. Schematic diagram of the relative positions of the elements of the JDataFrame Layout. Only a set
of numeric data (D) or alphanumeric notes (E) are required; all other elements are optional.

piece), B (numeric and/or notes column names), and C (row names) will automatically be gen-
erated upon import. If the dataset is subsequently exported to a delimited file, the elements A,
B1, C, and D will all be exported to the specified destination. Alphanumeric information (‘notes’)
can also be included for each row as long as it is located to the right of any columns of purely
numeric data.

This layout design allows some flexibility in how you choose to format data before importing
them into ArAR. For example, though you really only need to have numeric data in your input
file, you may also include column headers and sample IDs for convenience in recalculating K-Ar
or 40Ar/39Ar dates. In addition, you may include alhpanumeric notes to the right of the numeric
data, e.g., to indicate what paper the published date came from, or to indicate what constants were
originally used in calculating it.

It is also possible to include metadata in imported and exported datasets by including alphanu-
meric property:description pairs inside of a block of rows denoted by the ‘Begin Metadata’ and
‘End Metadata’ flags. An example of an acceptable input file with metadata is shown in Fig. 2.
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Begin Metadata

End Metadata

Sample ID

77115,75

77115,75

77115,22

77115,75

77115,22 3850

3900

3910

3960

3960

20

25

15

15

20 Stettler et al., 1975

Stettler et al., 1978

Stettler et al., 1975

Stettler et al., 1975

Stettler et al., 1978

Melt Matrix

Melt Matrix

Melt Matrix

Clast Material

Clast Material

Sample

Description

Locality

Station

Method

77115

Impact melt breccia

Taurus-Littrow Valley

Plateau Date (Ma) 1 σ (Ma) Reference Notes

Ar-Ar

7

Figure 2. An example of an acceptable data file that conforms to the JDataFrame format. Note that the
sample names and references use commas, and there are spaces in the metadata, references, and notes.
Therefore, this would not work as a *.csv or *.prn (space delimited) file unless alternate characters were
used. Be aware of the the file contents when choosing a delimiter.

3.2 Creating a New Dataset

To create a new dataset, click on the ‘File’ menu at the top of the ArAR window and select
‘New.’ Alternatively, you may use the hotkey combination ‘Meta + N’, where ‘Meta’ is the
‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh. By default, a dialog
window will appear prompting for the number of rows, numeric columns, and notes columns to
create (Fig. 3). This dialog may be disabled in the ArAR preferences pane (see Editing ArAR

Preferences), in which case new datasets are created with 10 rows and 2 numeric columns by
default. After the dataset dimensions are specified (or defaults are assumed), then the full dataset
editor tool (see Advanced JDataFrame Editor) is launched, allowing you to manually input data
(Fig. 4). Once you are done entering values, click ‘Save Changes’ to finish creating the new dataset.
The editor tool may also be disabled during the creation of new datasets in the ArAR preferences
pane, in which case a blank dataset is created. Note: entering data manually in the editor tool at
the time of dataset creation allows you to later revert any recalculated data to the values you first
entered. If you disable the editor, the original state of the new dataset is considered to be blank and
future reversion attempts will return the data to a blank state.

3.3 Importing Delimited Data

To import data from a delimited text file, click on the ‘File’ menu at the top of the ArAR window
and select ‘Open.’ You can also use the hotkey combination ‘Meta + O’, where ‘Meta’ is the
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Figure 3. Dialog box prompting for the dimensions of a new dataset.

Figure 4. Dataset editor for specifying the original state of a newly created dataset. See the Advanced
JDataFrame Editor section for additional details on using the editor.

‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh. A dialog window will
appear (Fig. 5) allowing you to browse for and select one or more of the allowable delimited file
types (*.csv, *.txt, *.prn, and *.jdf). Click ‘Open’ or press ‘Enter’ once you have finalized your
selection, and the files will be imported (provided they conform to the JDataFrame layout, see The
JDataFrame Layout).
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Figure 5. Dialog box for selecting files for import into ArAR.

3.4 Cut, Copy, and Paste

Cut, copy, and paste operations are available in the main ArAR window, the Advanced JDataFrame
Editor, and the Multiple Intercalibration Tool. You may use the appropriate items in the ‘Edit’
menu, or use one of the following hotkey combinations: ‘Meta + X’ (cut), ‘Meta + C’

(copy), and ‘Meta + V’ (paste), where ‘Meta’ is the ‘Ctrl’ key on a Windows machine
and the ‘Cmd’ key on a Macintosh.

3.5 Selecting, Renaming, and Removing Datasets

Once one or more datasets have been created or imported, you may select which dataset is
visible, rename the current dataset, and/or remove the current dataset using the controls located at
the bottom left of the main ArAR window (Fig. 6). By default, newly created datasets are named
‘New Dataset’ (or ‘Blank Dataset’ if created with the dataset editor disabled; see Creating a New
Dataset), and imported datasets inherit the names of the delimited files that are loaded. When
datasets are selected from the drop-down menu their contents are displayed in the table, and the
data are available for calculations (see Selecting Dates to Recalculate or Revert). To rename the
currently selected dataset, click the ‘Rename’ button; a dialog will appear allowing you to enter
a new name. Datasets can be removed (along with all of their contents and metadata, e.g., those
relating to sample selection states and change logs) using the ‘Remove’ button.
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Figure 6. The main ArAR window, with the controls to select, rename, and/or remove datasets highlighted
in the red box.

3.6 Exporting Delimited Data

To export the currently visible dataset to a delimited text file, click on the ‘File’ menu at the
top of the ArAR window and select ‘Save’ or ‘Save As.’ You can also use one of the hotkey
combinations: ‘Meta + S’ (‘Save’) or ‘Meta + Shift + S’ (‘Save As’), where ‘Meta’
is the ‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh. If a dataset has
not been exported previously, the ‘Save’ option behaves like ‘Save As,’ and opens a dialog window
(Fig. 7) allowing you to browse to a destination directory and provide a target file name. You may
also select one of the allowable delimited file types (*.csv, *.txt, *.prn, and *.jdf), and click ‘Save’
or press ‘Enter’ to export the dataset.

3.7 Exporting the Change Log

To export the change log (see The Change Log) for the currently visible dataset to a delimited
text file, click on the ‘File’ menu at the top of the ArAR window and select ‘Export Change Log.’
You can also use the hotkey combination ‘Meta + L’, where ‘Meta’ is the ‘Ctrl’ key on a
Windows machine and the ‘Cmd’ key on a Macintosh. A window similar to the ‘Save As’ dialog
will appear (Fig. 7) allowing you to browse to a destination directory and provide a target file
name. You may also select one of the allowable delimited file types (*.csv, *.txt, *.prn, and *.jdf),
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Figure 7. Dialog box for saving ArAR datasets to delimited text files.

and click ‘Save’ or press ‘Enter’ to export the change log. Alternatively, the change log may
be appended to the right of the active dataset when the dataset is exported using the ‘File > Save
As’ or ‘File > Save’ options. You may activate this behavior in the ArAR preferences pane (see
Editing ArAR Preferences).

4 Recalculating K-Ar and 40Ar/39Ar Dates

4.1 Selecting Dates to Recalculate or Revert

After importing or creating a new dataset, samples (i.e., rows in the dataset) are not selected
for recalculation by default. You may change this in the ArAR preferences pane (see Editing ArAR

Preferences) so that all samples are selected upon creation or import. In addition, there are a variety
of ways that you can edit the sample selection within the main ArAR window (Fig. 8). First, you
can toggle the selection state of individual samples by clicking on the checkboxes in the ‘Sel’
column of the displayed table. Alternatively, you may ‘Select All’ or ‘Deselect All’ samples in
a dataset using the buttons at the bottom left of the window. In addition, you can highlight rows
by clicking your mouse pointer within the table and dragging4, and then pressing the ‘Toggle’
button to invert their selection state. By right-clicking in the table (or holding down the ‘Ctrl’
key and clicking on a Mac), a contextual menu appears that allows you to either clear the current

4You can also highlight discontinuous groups of rows by holding down the ‘Ctrl’ key (for Windows) or the
‘Cmd’ key (on a Macintosh) while clicking and dragging within the table.
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Figure 8. The main ArAR window, with sample selection controls highlighted in the red box.

highlighting of samples or toggle the selection state of the highlighted rows (this is equivalent to
pressing the ‘Toggle’ button). The total number of samples (rows) that are selected in the current
dataset is displayed in the ‘Execute’ button located in the lower-right part of the ‘Calculation
Options’ subpanel in the main ArAR window (Fig. 8).

The checkboxes in the ‘Sel’ column of the table (Fig. 8) only indicate which samples (rows) of
the visible dataset are ‘active’ for K-Ar or 40Ar/39Ar recalculation. By default, only those numeric
data that are located in the first two columns immediately to the right of the ‘Sel’ column will
be used during ArAR calculations. This assumes that the data in the first numeric column are
K-Ar or 40Ar/39Ar dates and that the data in the second numeric column are their corresponding
uncertainties. These ‘active columns’ may be changed by clicking the ‘Data Column Selection’
button (Fig. 9) near the bottom of the table. A dialog will appear (Fig. 10) allowing you to specify
which columns to use for the K-Ar or 40Ar/39Ar dates and uncertainties in ArAR calculations. This
gives you some flexibility in your age recalculations as well. For example, you could import a file
with 40Ar/39Ar dates as well as the ages of the monitor minerals that were used to determine the
published 40Ar/39Ar dates. You could then process the monitor ages before using the recalculated
values to crunch the 40Ar/39Ar dates (see Recalculating 40Ar/39Ar Dates), thereby streamlining
your workflow by using a single imported dataset.

Finally, the data in the active columns of the selected sample rows can be reverted to their
original state by clicking on the ‘Revert Data’ button near the bottom of the table in the main ArAR
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Figure 9. The main ArAR window, with the ‘Data Column Selection’ control highlighted in the red box.

Figure 10. The ‘Data Column Selection’ dialog box.

window (Fig. 11). This allows you to recover the raw data after they have been edited (e.g., by
recalculating dates or manually editing values) without having to reimport the original file.

4.2 Recalculating K-Ar Dates

By default, ArAR opens with the K-Ar algorithm selected (indicated by the radio button in the
‘Calculation Options’ subpanel on the right side of the main ArAR window; Fig. 12). This can be
changed to make ArAR start with the 40Ar/39Ar algorithm selected using the preferences pane (see
Editing ArAR Preferences). If the K-Ar algorithm is not selected, you may switch to it by clicking
on the appropriate radio button in the ‘Calculation Options’ subpanel.

In addition, calculations in ArAR are performed assuming that any new or imported dates are in
units of Ma by default (indicated by the radio button in the ‘Calculation Options’ subpanel on the
right side of the main ArAR window; Fig. 12). This can be changed to make ArAR use units of ka,
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Figure 11. The main ArAR window, with the ‘Revert Data’ control highlighted in the red box.

Ma, or Ga for imported dates using the preferences pane (see Editing ArAR Preferences). You may
switch to the correct units of time by clicking on the appropriate radio button in the ‘Calculation
Options’ subpanel. Note: the units of time selected in the ‘Calculation Options’ subpanel only
apply to dates visible in the ‘Data Window’ on the left side of the main ArAR window; all other
input values are assumed to be in the units that are shown in the ArAR interface.

To recalculate legacy K-Ar dates you must specify both ‘old’ and ‘new’ values for the 40K
decay constants (in particular, the total decay constants [λo ≡ λ40Aro + λβo] and [λ ≡ λ40Ar + λβ]),
and the relative abundances of the isotopes of K (in particular, the relative abundance of 40K, i.e.,
40Kao and 40Ka). (Note: All uncertainties for input parameters in ArAR are assumed to be 1σ

values.) You may directly enter values for these quantities in the editable text fields (remember to
press ‘Enter’ after editing a value!), or you may auto-fill these values by selecting references
from the ArAR libraries using the drop-down menus (Fig. 12). When editing or selecting values for
the ‘old’ and ‘new’ 40K decay constants, the total decay constants and their uncertainties (λo±σλo
and λ±σλ) are calculated from the partial decay constants by default5. You may edit the values for
the total decay constants by unchecking the ‘Use Calculated Values’ check boxes in the K decay
constants subpanels. Also, you may alter the default behavior to always require manual input for
the total decay constants using the ArAR preferences pane (see Editing ArAR Preferences). The
values and uncertainties for the branching ratio (e.g., λ40Ar/λ), half-life, and mean life of 40K are

5Note (without loss of generality) that λ ≡ λ40Ar + λβ . The uncertainties in the decay constants are propagated
analytically as σλ = (σ2

λ40Ar
+ σ2

β)
1/2.
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Figure 12. An example of the GUI controls on the right side of the main ArAR window that are used for
recalculating K-Ar dates.

calculated from the decay constants you specify, and are displayed for convenience (Fig. 12).
If you have auto-filled 40K decay constants or K isotopic abundances from the ArAR libraries

and subsequently edited the values, buttons with icons will appear next to the drop-down menus.
If you click on these buttons, you will see a dialog box warning you that you have edited library
values. If you have intentionally done so, it is safe to continue and recalculate the K-Ar dates.
If you intend to use one or more of the edited values regularly, consider adding an entry to the
appropriate ArAR library (see The ArAR Libraries), though the value should ideally be traceable to
the peer-reviewed literature.

If uncertainties are missing for any 40K decay constants or K isotopic abundance values from
the ArAR library (e.g., if the selected reference did not report them), buttons with icons will
appear next to the drop-down menus (e.g., Fig. 12). If you click on these buttons, you will see a
dialog box warning you that the auto-filled uncertainties were assumed to be some percentage of
their corresponding quantities. By default, the assumed relative uncertainties in all quantities are
assumed to be 1 %. You may edit these default relative uncertainty values in the ArAR preferences
pane (see Editing ArAR Preferences). These default (assumed) uncertainties are of course arbitrary,
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and are meant only to provide some non-zero values in the event that you would like to propagate
external sources of uncertainty into recalculated K-Ar dates.

Once values for the 40K decay constants and K isotopic abundance values have been speci-
fied, you can select uncertainty propagation options in the ‘Calculation Options’ subpanel located
at the bottom on the right side of the main ArAR window. By checking the ‘Propagate External
Uncertainties from:’ checkbox, you can decide to have the uncertainties for either the 40K decay
constants, K isotopic abundances, or both propagated into recalculated K-Ar dates. In addition,
you can select whether to propagate uncertainties analytically or by a Monte Carlo approach using
the specified synthetic population size (see Calculations). By default, no external sources of un-
certainty are propagated, but if you check the ‘Propagate External Uncertainties from:’ box then
all external uncertainties will be propagated unless otherwise specified. Error propagation is per-
formed analytically by default, but if you chose to employ Monte Carlo error propagation, a default
population size of 8192 (i.e., 213) is used. To edit the population size, you may enter integer val-
ues or powers using the ‘∧’ character. For example, if you enter ‘2∧14’ in the text field and press
‘Enter’, the population size will be set to 214 = 16384. The default values for all options in
the ‘Calculation Options’ subpanel can be edited in the ArAR preferences pane (see Editing ArAR

Preferences).
If you would like to preview the effects of recalculating K-Ar dates with the constants and

options you have entered/selected, you can click the ‘Preview’ button located in the ‘Calculation
Options’ subpanel above the ‘Execute’ button, select the ‘Preview Results’ item from the ‘Tools’
menu, or use the hotkey combination ‘Meta + P’, where ‘Meta’ is is the ‘Ctrl’ key on a
Windows machine and the ‘Cmd’ key on a Macintosh (see Previewing Recalculation Results for
more information). To recalculate the selected K-Ar dates using the constants and options that you
have entered/selected, press the ‘Execute’ button in ‘Calculation Options’ subpanel (Fig. 12). See
the Calculations documentation for details on the equations used for recalculating K-Ar dates.

4.3 Recalculating 40Ar/39Ar Dates

By default, ArAR opens with the K-Ar algorithm selected (indicated by the radio button in the
‘Calculation Options’ subpanel on the right side of the main ArAR window; Fig. 13). This can
be changed to make ArAR start with the 40Ar/39Ar algorithm selected in the preferences pane (see
Editing ArAR Preferences). If the 40Ar/39Ar algorithm is not selected, you may switch to it by
clicking on the appropriate radio button in the ‘Calculation Options’ subpanel.

In addition, calculations in ArAR are performed assuming that any new or imported dates are in
units of Ma by default (indicated by the radio button in the ‘Calculation Options’ subpanel on the
right side of the main ArAR window; Fig. 13). This can be changed to make ArAR use units of ka,
Ma, or Ga for imported dates using the preferences pane (see Editing ArAR Preferences). You may
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Figure 13. An example of the GUI controls on the right side of the main ArAR window that are used for
recalculating 40Ar/39Ar dates.

switch to the correct units of time by clicking on the appropriate radio button in the ‘Calculation
Options’ subpanel. Note: the units of time selected in the ‘Calculation Options’ subpanel only
apply to dates visible in the ‘Data Window’ on the left side of the main ArAR window; all other
input values are assumed to be in the units that are shown in the ArAR interface.

To recalculate legacy 40Ar/39Ar dates you must specify both ‘old’ and ‘new’ values for the 40K
decay constants (in particular, the total decay constants [λo ≡ λ40Aro + λβo] and [λ ≡ λ40Ar + λβ]),
and the age of the monitor mineral that was used in the 40Ar/39Ar experiment (i.e., tmo and tm).
(Note: All uncertainties for input parameters in ArAR are assumed to be 1σ values.) You may
directly enter values for these quantities in the editable text fields (remember to press ‘Enter’
after editing a value!), or you may auto-fill these values by selecting references from the ArAR

libraries using the drop-down menus (Fig. 13). When editing or selecting values for the ‘old’ and
‘new’ 40K decay constants, the total decay constants and their uncertainties (λo ± σλo and λ± σλ)
are calculated from the partial decay constants by default6. You may edit the values for the total

6Note (without loss of generality) that λ ≡ λ40Ar + λβ . The uncertainties in the decay constants are propagated
analytically as σλ = (σ2

λ40Ar
+ σ2

β)
1/2.
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Figure 14. Another example of the GUI controls on the right side of the main ArAR window that are used
for recalculating 40Ar/39Ar dates. In this case, values for the ‘new’ age of the monitor mineral are sourced
from the ‘Monitor Ages (Ma)’ column of the active dataset.

decay constants by unchecking the ‘Use Calculated Values’ check boxes in the K decay constants
subpanels. Also, you may alter the default behavior to always require manual input for the total
decay constants using the ArAR preferences pane (see Editing ArAR Preferences). The values and
uncertainties for the branching ratio (e.g., λ40Ar/λ), half-life, and mean life of 40K are calculated
from the decay constants you specify, and are displayed for convenience (Fig. 13).

To select monitor mineral ages from the ArAR library, you must select both a mineral name and
a reference from the drop-down menus in the monitor mineral age subpanels. You may also choose
to use external uncertainties for the monitor ages (if they were reported by the selected reference
and are present in the ArAR library) by checking the ‘Use External Uncertainties’ boxes (Fig. 13).
By default, only the internal uncertainties are used (i.e., the ‘Use External Uncertainties’ boxes are
unchecked). If you do not want to use the library values for monitor mineral ages, you can uncheck
the ‘Use Library Values’ boxes and select a column in the active dataset from which to source the
monitor ages (Fig. 14). If the uncertainties in the monitor age values are going to be propagated
into the recalculated 40Ar/39Ar dates (see below), then the uncertainties are assumed to be in the
column immediately to the right of the selected source column. This gives you some flexibility
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in your 40Ar/39Ar age recalculations. For example, you could import a file with 40Ar/39Ar dates
as well as the ages of the monitor minerals that were used to determine the published 40Ar/39Ar
dates. You could first process the monitor ages (by changing the active columns to the monitor
dates, see Selecting Dates to Recalculate or Revert), and then use the recalculated values to crunch
the 40Ar/39Ar dates (by swapping the active columns back to the 40Ar/39Ar dates and selecting the
recalculated monitor values in the monitor mineral age subpanels). This can help to streamline your
workflow by using a single imported dataset rather than separate datasets. Note that all defaults for
the monitor mineral age subpanels may be edited in the ArAR preferences pane (see Editing ArAR

Preferences).
If you have auto-filled 40K decay constants or monitor mineral ages from the ArAR libraries and

subsequently edited the values, buttons with icons will appear next to the drop-down menus.
If you click on these buttons, you will see a dialog box warning you that you have edited library
values. If you have intentionally done so, it is safe to continue and recalculate the 40Ar/39Ar dates.
If you intend to use one or more of the edited values regularly, consider adding an entry to the
appropriate ArAR library (see The ArAR Libraries), though the value should ideally be traceable to
the peer-reviewed literature.

If uncertainties are missing for any 40K decay constants or monitor mineral ages from the ArAR

library (e.g., if the selected reference did not report them), buttons with icons will appear next
to the drop-down menus (e.g., Fig. 12). If you click on these buttons, you will see a dialog box
warning you that the auto-filled uncertainties were assumed to be some percentage of their corre-
sponding quantities. By default, the assumed relative uncertainties in all quantities are assumed to
be 1 %. You may edit these default relative uncertainty values in the ArAR preferences pane (see
Editing ArAR Preferences). These default (assumed) uncertainties are of course arbitrary, and are
meant only to provide some non-zero values in the event that you would like to propagate external
sources of uncertainty into recalculated 40Ar/39Ar dates.

Once values for the 40K decay constants and monitor mineral ages have been specified, you can
select uncertainty propagation options in the ‘Calculation Options’ subpanel located at the bottom
on the right side of the main ArAR window. By checking the ‘Propagate External Uncertainties
from:’ checkbox, you can decide to have the uncertainties for either the 40K decay constants, mon-
itor mineral ages, or both propagated into recalculated 40Ar/39Ar dates. In addition, you can select
whether to propagate uncertainties analytically or by a Monte Carlo approach using the specified
synthetic population size (see Calculations). By default, no external sources of uncertainty are
propagated, but if you check the ‘Propagate External Uncertainties from:’ box then all external
uncertainties will be propagated unless otherwise specified. Error propagation is performed ana-
lytically by default, but if you chose to employ Monte Carlo error propagation, a default population
size of 8192 (i.e., 213) is used. To edit the population size, you may enter integer values or powers
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using the ‘∧’ character. For example, if you enter ‘2∧14’ in the text field and press ‘Enter’, the
population size will be set to 214 = 16384. The default values for all options in the ‘Calculation
Options’ subpanel can be edited in the ArAR preferences pane (see Editing ArAR Preferences).

If you would like to preview the effects of recalculating 40Ar/39Ar dates with the constants
and options you have entered/selected, you can click the ‘Preview’ button located in the ‘Calcula-
tion Options’ subpanel above the ‘Execute’ button, or use the hotkey combination ‘Meta + P’,
where ‘Meta’ is is the ‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh
(see Previewing Recalculation Results for more information). To recalculate the selected 40Ar/39Ar
dates using the constants and options that you have entered/selected, press the ‘Execute’ button in
‘Calculation Options’ subpanel (Fig. 13). See the Calculations documentation for details on the
equations used for recalculating 40Ar/39Ar dates.

4.4 The Main ArAR Change Log

For each sample (i.e., row) in datasets that are loaded into or created within ArAR, there is a
change log that tracks all information relevant to recalculating K-Ar or 40Ar/39Ar dates, as well as
ancillary information related to the 40K decay contants, K isotopic abundances, monitor minerals,
and any warnings that have been activated (e.g., if you have edited values from the ArAR libraries,
or if relative uncertainties have been assumed where values are missing). The change log is in-
tended to preserve a complete record of all age recalculations, and can be exported either on its
own or appended to the right of its affiliated dataset (see Exporting the Change Log). To quickly
view the recalculation history of K-Ar and/or 40Ar/39Ar dates in ArAR, see the section on Viewing
the Recalculation History.

The values that are required to recalculate K-Ar dates are: to, λ40Aro , λo, λ40Ar, λ, 40Kao, and
40Ka. These quantities and their 1σ uncertainties are all recorded in the change log, along with the
recalculated K-Ar date, t.

The values that are required to recalculate 40Ar/39Ar dates are: to, λo, λ, tmo , and tm. These
quantities and their 1σ uncertainties are all recorded in the change log, along with the recalculated
40Ar/39Ar date, t.

If a K-Ar or 40Ar/39Ar date is recalculated multiple times (e.g., by converting first to one set of
constants, and then from those to a second set), the change log for that date will preserve all of the
values used for each step.

For a full list and explanations of the quantities that are recorded in the main ArAR change log,
see the Nomenclature documentation.

5 Additional Tools
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Figure 15. The advanced JDataFrame Editor with the example dataset from Fig. 2 shown. Note that the
add/remove rows/columns buttons and contextual menu items operate based on the number and locations of
highlighted cells. The ‘Editing Options’ are accessible from both the contextual menu and the drop-down
menu of the same name at the top left of the JDataFrame Editor window.

5.1 Advanced JDataFrame Editor

While the numeric data and notes of a dataset can be edited directly in the main ArAR window,
the advanced JDataFrame Editor (Fig. 15) provides a number of additional editing capabilities. The
advanced editor can be accessed by selecting the ‘Edit Dataset’ item from the ‘Tools’ menu, or by
using the hotkey combination ‘Meta + E’, where ‘Meta’ is is the ‘Ctrl’ key on a Windows
machine and the ‘Cmd’ key on a Macintosh. In the JDataFrame Editor, you may edit the column
names and row names of the dataset (remember to press ‘Enter’ when you are done!) as well
as the numeric data and notes. You may also insert or append rows and columns relative to cells
that you highlight by clicking and dragging your mouse cursor in the table. Rows can either be
added above or below the highlighted cells, and columns can be added to the right or left of the
highlighted cells. To choose between these options, you can click on the ‘Editing Options’ menu
in the top left of the JDataFrame Editor window, or right-click in the table to activate a contextual
menu and access the editing options (Fig. 15). Additionally, you may choose to have the inserted
rows or columns interleaved with the cells that you highlight (activate this behavior in the ‘Editing
Options’). An example of this would be if you imported a dataset without uncertainties for multiple
columns of dates, and you would like to insert columns to the right of each column of dates. You
may clear the current highlighting of cells using the contextual menu. Finally, you may revert all
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Figure 16. The advanced JDataFrame Editor with the metadata for the example dataset from Fig. 2 shown.
Note that only the add/remove rows buttons (and contextual menu items) are enabled when editing metadata.

of the data to their original (un-edited) state by clicking on the ‘Revert Data’ button or selecting
the contextual menu item of the same name.

In addition to viewing and editing the contents of a dataset, the advanced JDataFrame Editor
allows you to view any metadata that are associated with the data (Fig. 16). This allows you to
edit any of the existing metadata properties and descriptions, as well as add or remove metadata
entries.

Once you are done editing the data and/or metadata in the JDataFrame Editor, you can click
‘Save Changes’ to transfer your modifications to the main ArAR window, or click ‘Cancel’ to scrap
your changes. If you have added or removed rows or columns to the dataset, then a new dataset is
created with the string ‘Edited’ appended to the name of the original dataset, and both the original
and edited datasets are selectable from the drop-down menu at the bottom left of the main ArAR

window.

5.2 Previewing Recalculation Results

Once you have specified values for the 40K decay constants and K isotopic abundances (for
the K-Ar algorithm) or monitor mineral ages (for the 40Ar/39Ar algorithm), you can preview the
effects of recalculating K-Ar and 40Ar/39Ar dates. This does not require a dataset to be created
or imported. Rather, a synthetic set of dates are automatically generated that span the age of the
Solar System, and they are recalculated using your present selection of constants. The results are
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Figure 17. An example preview plot of recalculation results, shown as a percentage change from the original
synthetic dates.

plotted either as a percentage change from the original synthetic dates (Fig. 17), or on a plot of
recalculated vs. original dates (Fig. 18). These preview plots can be opened by: (1) clicking on
the ‘Preview’ button located just above the ‘Execute’ button in the ‘Calculation Options’ subpanel
(e.g., Fig. 14); (2) by selecting the ‘Preview Results’ item from the ‘Tools’ menu; or (3) by using
the hotkey combination: ‘Meta + P’, where ‘Meta’ is is the ‘Ctrl’ key on a Windows
machine and the ‘Cmd’ key on a Macintosh.

Once the preview plot panel is open, you can switch between the two plot types using the ra-
dio buttons at the bottom left of the figure. In addition, you can choose to show the propagated
uncertainties on the plots by clicking the ‘Show Error Bars’ button. By default, the relative un-
certainty for the original synthetic dates is assumed to be 1 %, but you can freely edit this value
(using the text field that appears when the ‘Show Error Bars’ button is selected), and the plot will
automatically update to use the new value.

You can zoom into the plot by clicking your mouse cursor on the plot and dragging down and
to the right to select a smaller sub-region. To zoom back out, click your mouse cursor on the plot
and drag up and to the left. If you would like to export a copy of the preview plot, use the ‘Save
Plot’ button in the lower right corner of the preview panel, and specify a destination for the file.
You can export the plots as either *.png or *.jpeg files. To return to the main ArAR window, click
the ‘Close’ button.
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Figure 18. An example preview plot of recalculation results, showing the recalculated dates versus the
original synthetic dates.

5.3 Viewing the Recalculation History

You may view the change history after recalculating K-Ar or 40Ar/39Ar dates one or more times
by selecting the ‘View Recalculation History’ item from the ‘Tools’ menu or by using the hotkey
combination ‘Meta + Shift + H’, where ‘Meta’ is is the ‘Ctrl’ key on a Windows
machine and the ‘Cmd’ key on a Macintosh. The ‘Recalculation History’ dialog box will appear
(Fig. 19) containing the change history of the dates that are selected in the main ArAR window
(see Selecting Dates to Recalculate or Revert). The dialog shows: (1) the row names associated
with each recalculated date; (2) four columns with the original and recalculated dates and their
uncertainties (i.e., to, σto , t, and σt) for each time that you executed calculations; and (3) a column
listing the units of time associated with each set of calculations. The column names for the original
and recalculated dates conform to the conventions used in the main ArAR change log (see the
Nomenclature documentation). Note: the values that are displayed in the Recalculation History
Tool are not affected by rounding (see the section on the Rounding Tool).

5.4 Rounding Measurements to the Proper Number of Significant Digits

After recalculating K-Ar and 40Ar/39Ar dates, the results are stored as double-precision 64-bit
IEEE 754 floating point numbers. You can either round the results yourself outside of ArAR, or
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Figure 19. The ArAR Recalculation History Tool dialog box, with an example synthetic dataset that has
been recalculated once.

Figure 20. The ArAR Rounding Tool dialog box.

you can use the built-in rounding tool by selecting the ‘Round to Sig Figs’ item from the ‘Tools’
menu or by using the hotkey combination ‘Meta + R’, where ‘Meta’ is is the ‘Ctrl’ key
on a Windows machine and the ‘Cmd’ key on a Macintosh. The ‘Rounding Tool’ dialog box will
appear (Fig. 20) prompting you for the number of significant figures7 to round to (the default is
2). By default, only those data in the selected rows are rounded, but you can override this in the
dialog box by checking the ‘Round all dates in dataset’ box. By clicking ‘OK’, the data in the
active columns (see Selecting Dates to Recalculate or Revert) will be rounded using the following

7To learn about significant figures, see: http://en.wikipedia.org/wiki/Significant_figures.
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method. First, the uncertainty for each date will be rounded to the specified number of significant
figures. Next, the corresponding date will be rounded to the same decimal location as the least
significant digit in the uncertainty. All rounding is performed using the unbiased ‘round-half-
to-even’ approach (see http://en.wikipedia.org/wiki/Rounding#Round_half_

to_even).
Warning: After using the ArAR Rounding Tool, you will still need to visually inspect the

rounded results to ensure that the dates and uncertainties are displayed with the proper number
of digits/decimals/significant figures. This is because of how Java and other software packages,
such as Microsoft Excel, handle the display of floating point numbers in a table. Specifically,
most software packages trim trailing zeros from decimal numbers (under the assumption that such
an action should be considered a feature rather than a bug). For example, if there is a rounded
date that should be represented as ‘124.20 ± 0.58 Ma’ (2 significant figures in the uncertainty),
ArAR (and Excel) will instead show the date as ‘124.2’ and the uncertainty as ‘0.58’ by default.
As another example, the rounded date ‘236.2 ± 1.0 Ma’ (2 significant figures in the uncertainty)
will be incorrectly displayed with the values ‘236.2’ and ‘1’. Thus, while the ArAR Rounding
Tool can do much of the leg-work for you, you must be on the lookout for the rather unfortunate
‘trim-the-trailing-zeros’ feature of many spreadsheet-based programs (including ArAR).

5.5 The Multiple Intercalibration Tool

The ArAR Multiple Intercalibration Tool allows a K-bearing sample to be intercalibrated rela-
tive to a ‘primary’ standard and an arbitrary number of secondary standards with known K-Ar or
40Ar/39Ar ages. Note, the Multiple Intercalibration Tool cannot be used to account for differences
in 40K decay constants, K isotopic abundances, or monitor mineral ages. Furthermore, it should
only be used with data from samples that were irradiated simultaneously and in the same position
within the package the was sent to a nuclear reactor. See the Calculations documentation for details
on the equations used for multiple intercalibration of coirradiated samples.

The Multiple Intercalibration Tool can be opened by selecting the ‘Multiple Intercalibration’
item from the ‘Tools’ menu or by using the hotkey combination: ‘Meta + M’, where ‘Meta’
is is the ‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh. The ‘Multiple
Intercalibration Tool’ window will appear (Fig. 21), allowing you to specify all of the parameters
that are required to intercalibrate a sample. In the ‘Algorithm Selection’ subpanel, you can select
one of two forms for the data required for the primary standard, and you can select one of two
forms for the data required for the intercalibration factors, Ri+1

i . The equations show in the ‘Al-
gorithm Selection’ subpanel will update, and input fields for quantities in the ‘Sample/Unknown’,
‘Primary Standard’, and ‘Secondary Standard(s)’ subpanels will be enabled or disabled, to reflect
your algorithm selections.
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Figure 21. The ArAR Multiple Intercalibration Tool window, shown in its default state.

In the ‘K Decay Constants’ subpanel, you may directly enter values for the 40K decay constants
(remember to press ‘Enter’ after editing a value!), or you may auto-fill these values by selecting
references from the ArAR library using the drop-down menu. (Note: All uncertainties for input pa-
rameters in the ArAR Multiple Intercalibration Tool are assumed to be 1σ values.) When editing or
selecting values for the 40K decay constants, the total decay constant and its associated uncertainty
(λ ± σλ) are calculated from the partial decay constants by default8. You may edit the values for
the total decay constants by unchecking the ‘Use Calculated Values’ check boxes in the ‘K Decay
Constants’ subpanel. Also, you may alter the default behavior to always require manual input for
the total decay constants using the ArAR preferences pane (see Editing ArAR Preferences).

8Note (without loss of generality) that λ ≡ λ40Ar + λβ . The uncertainties in the decay constants are propagated
analytically as σλ = (σ2

λ40Ar
+ σ2

β)
1/2
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In the ‘Primary Standard’ subpanel, you may specify the name and values for the age (t0 ±
σt0), κ value (40Ar∗/40K ± σ40Ar∗/40K), and/or the measured 40Ar∗/39ArK ratio (±σ40Ar∗/39ArK ) of
the primary standard. The information that you are required to enter depends on your algorithm
selections and whether you have checked the boxes labelled ‘Calculate κ from standard age’ or
‘Calculate standard age from κ’ (only one of which will be visible, depending on your primary
algorithm selection and assuming you have selected the (40Ar∗/39ArK) algorithm for the form of
Ri+1
i ). You will be able to auto-fill values from either the library of monitor ages or the library

of monitor κ values depending on your algorithm selections. If you have selected the (40Ar∗/40K)
primary monitor algorithm and the (exp[λt] − 1) algorithm for the form of Ri+1

i , you will be able
to select either the ‘Monitor Age Library’ or the ‘Monitor κ Library’ as the source for auto-filled
values. If you selected the (exp[λt] − 1) options for both of the algorithms, you can only auto-fill
values from the monitor age library. In most cases, κ will be calculated automatically from the
primary standard age, t0, or vice versa, depending on your algorithm and library source selections.
(Note: you will see ‘NaN’ values if you have not specified values for the 40K decay constants.) If
both sets of input fields are enabled for the primary standard age and κ values, you can manually
enter values for both quantities to override any calculated values.

In the ‘Sample/Unknown’ and ‘Secondary Standard(s)’ subpanels, you may specify the name
and values for either the age (tn−1 ± σtn−1) or the measured 40Ar∗/39ArK ratio (±σ40Ar∗/39ArK )
of the sample/unknown that is being intercalibrated or a secondary standard. The information
that you are required to enter depends on your algorithm selection for Ri+1

i . If the fields for
the sample/unknown/secondary standard age are enabled, you may auto-fill the values from the
ArAR library by selecting a standard name and reference from the dropdown menus (see Fig. 21).
Once you have specified the required data in the ‘Secondary Standard(s)’ subpanel, you must
append/insert those values into the secondary standards list using the appropriate buttons. If you
would like to modify the data shown for a standard in the list, you can specify the values in the
appropriate fields, highlight the standard in the list that you would like to update by clicking on it,
and then click the ‘Replace’ button. To remove a standard from the list, highlight it and click the
‘Remove’ button. If no standard is highlighted in the list, the ‘Insert’ button will append data to
the end of the list, the ‘Replace’ button will update the last standard in the list, and the ‘Remove’
button will remove the last standard from the list. Use the buttons with the up/down arrows to shift
selected standards up or down in the list. If no standard is highlighted in the list, the arrow buttons
will do nothing. If you check the box labelled ‘Use last secondary standard as unknown’ in the
‘Sample/Unkown’ subpanel, then all controls in that panel will be disabled and the data entered
for the last secondary standard that is appended to the list will be used for the sample/unknown.

As you begin specifying values in the ‘K Decay Constants’, ‘Sample/Unknown’, ‘Primary
Standard’, and/or ‘Secondary Standard(s)’ subpanels, you will notice large warning buttons near
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the bottom left of the ‘Intercalibration Options and Results’ subpanel. You may click on the warn-
ing buttons to see which values you are missing. These warning buttons will disappear once you
have entered the minimum amount of information that is required for multiple intercalibration cal-
culations, and the ‘Execute’ button will light up. Also in the ‘Intercalibration Options and Results’
subpanel, you have the option to propagate external uncertainties (from the 40K decay constants),
and you can select whether error propagation will be performed analytically or by a Monte Carlo
approach. (See the Calculations documentation for details on error propagation.)

If you have added data for at least one sample/unknown and one secondary standard and have
the (40Ar*/39ArK) algorithm selected for the form of Ri+1

i , a checkbox labelled ‘Perform Addi-
tional Intercalibration with Mean 40Ar*/39ArK Value’ will appear. If all of the sample/unknown
and ‘secondary standard’ grains are the same mineral type and are from the same rock (and were
coirradiated)9, consider selecting this checkbox. This activates a supplementary intercalibration
algorithm where the mean 40Ar*/39ArK value is determined before calculating the intercalibration
factor between the sample S and the primary monitor P , RS

P . When you check the ‘Perform Ad-
ditional Intercalibration with Mean 40Ar*/39ArK Value’ box, additional calculation options appear
(Fig. 22). In particular, you may select whether the Multiple Intercalibration Tool calculates an
arithmetic or an inverse-variance weighted mean 40Ar*/39ArK value from the sample data. If you
select the arithmetic mean, you also have the option of having the Multiple Intercalibration Tool
calculate the standard deviation or the standard deviation of the mean for the mean 40Ar*/39ArK
value. Finally, if you check the ‘Perform Additional Intercalibration with Mean 40Ar*/39ArK Value’
box, an additional checkbox appears that is labelled ‘Expand Uncertainties for Mean’. This is se-
lected by default, and the Multiple Intercalibration Tool will expand the uncertainty for the mean
40Ar*/39ArK value if it detects a high degree of dispersion in the sample data. (See the Calculations
documentation for more details on the uncertainty types, how they are used in error propagation,
and how the error expansion is performed.)

Once you have finished specifying the input parameters and calculation options, click the ‘Ex-
ecute’ button to perform intercalibration calculations. The text field on the right side of the ‘In-
tercalibration Options and Results’ subpanel (which contains basic instructions the first time you
open the Multiple Intercalibration Tool, e.g., Fig. 22) will fill with a report of results. Note that
all values and their associated uncertainties have been rounded as if by the Rounding Tool using
two significant figures. Additionally, the ‘Export...’ button will light up at the bottom right corner
of the Multiple Intercalibration Tool window. When you click on the ‘Export...’ button, a dialog
appears allowing you to specify a folder in which to export the ‘Intercalibration Summary Report’
and/or the ‘Full Intercalibration Log’ (Fig. 23). The ‘Intercalibration Summary Report’ is exported

9If these conditions apply, the distinction between sample/unknown and secondary standards no longer applies,
and the ArAR Multiple Intercalibration Tool can treat them as a single group.
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Figure 22. The ArAR Multiple Intercalibration Tool window, shown with supplemental intercalibration
options in the ‘Intercalibration Options and Results’ subpanel.

as a plain text file, and contains an exact copy of the results shown in the text field at the bottom
right corner of the Multiple Intercalibration Tool. The ‘Full Intercalibration Log’ is exported as
a tab-delimited file (openable in Excel), and contains all intercalibration results, input values, al-
gorithm selections, and calculation options that were used by the Multiple Intercalibration Tool.
(Note: all values exported in the ‘Full Intercalibration Log’ are shown to the tenth decimal place.)
See the Nomenclature documentation for details on all of the quantities that are exported in the
‘Full Intercalibration Log’.
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Figure 23. The Export Multiple Intercalibration Reports dialog.

6 The ArAR Libraries

To facilitate rapidly recalculating K-Ar and 40Ar/39Ar dates, ArAR has four user-editable li-
braries containing values for: (1) 40K decay constants, (2) K isotopic abundances, (3) ages re-
ported for common monitor minerals, and (4) 40Ar*/40K values for common monitor minerals.
The default libraries that are distributed with ArAR only contain some of the more common sets
of constants for these three quantities, and are undoubtedly incomplete. Thus, you can freely edit
the ArAR libraries, either directly within ArAR, or by editing the tab-delimited text files in the
‘Library’ directory, which is extracted when ArAR starts. You can open a library for editing by
selecting from the ‘Library’ menu. A JDataFrame Editor will launch, allowing you to modify the
contents and metadata for the selected library (e.g., Fig. 24). However, you will be unable to add
or remove columns to the libraries. This is because the libraries are expected to conform to a strict
layout and column order. If you edit the libraries using software other than ArAR (e.g., using Mi-
crosoft Excel), do not add, remove, or rearrange the columns. To recover a default ArAR library,
simply delete the library in question from the ‘Library’ directory and restart ArAR; a new copy
will be extracted. However, be aware that any entries you have made will be lost. If you have
suggestions for library entries that should be included with ArAR by default, please contact me at:
cameron.m.mercer@asu.edu.

See the Nomenclature documentation for an explanation of the plain-text column headings that
appear in the tab-delimited text files of the ArAR libraries. Also, see the section on the Advanced
JDataFrame Editor for more information on how to edit the ArAR libraries.

6.1 40K Decay Constants

The 40K decay constants library contains the following columns of information (in the specified
order, from left to right): (1) a short reference (this is used in the drop-down menus in the main
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Figure 24. An example of editing an ArAR library. The 40K decay constants library is shown here.

ArAR GUI); (2) the partial decay constant of 40K that accounts for the production of 40Ar, λ40Ar; (3)
the 1σ uncertainty in λ40Ar, i.e., σλ40Ar ; (4) the partial decay constant of 40K that accounts for the
production of 40Ca, λβ; (5) the 1σ uncertainty in λβ , i.e., σλβ ; and (6) the full reference from which
the values for λ40Ar and λβ were sourced. The number ‘−1’ indicates that a value was not reported
by the reference from which the data were taken. The 40K decay constants library is stored in the
tab-delimited text file named ‘arLib K dc.txt’ in the ‘Library’ directory.

6.2 K Isotopic Abundances

The library of K isotopic abundance values contains the following columns of information (in
the specified order, from left to right): (1) a short reference (this is used in the drop-down menus in
the main ArAR GUI); (2) the abundance of 39K relative to total K, 39Ka; (3) the 1σ uncertainty in
39Ka, i.e., σ39Ka; (4) the abundance of 40K relative to total K, 40Ka; (5) the 1σ uncertainty in 40Ka,
i.e., σ40Ka; (6) the abundance of 41K relative to total K, 41Ka; (7) the 1σ uncertainty in 41Ka, i.e.,
σ41Ka; (8) the ratio 39Ka/

41Ka; (9) the 1σ uncertainty in 39Ka/
41Ka, i.e., σ39Ka/41Ka; (10) the ratio

41Ka/
40Ka; (11) the 1σ uncertainty in 41Ka/

40Ka, i.e., σ41Ka/40Ka; and (12) the full reference from
which the K isotopic abundance values were sourced. The number ‘−1’ indicates that a value was
not reported by the reference from which the data were taken. The library of K isotopic abundance
values is stored in the tab-delimited text file named ‘arLib K ia.txt’ in the ‘Library’ directory.
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6.3 Monitor Mineral Ages

The monitor mineral age library contains the following columns of information (in the specified
order, from left to right): (1) the name of the monitor mineral (this is used in the drop-down menus
in the main ArAR GUI); (2) the age of the monitor mineral, in units of Ma; (3) the internal 1σ
uncertainty in the monitor mineral age; (4) the external 1σ uncertainty in the monitor mineral age;
(5) a short reference (this is used in the drop-down menus in the main ArAR GUI); (6) the full
reference from which the monitor mineral age was sourced; and (7) miscellaneous notes about a
particular monitor mineral and reference. The number ‘−1’ indicates that a value was not reported
by the reference from which the data were taken. The monitor mineral age library is stored in the
tab-delimited text file named ‘arLib M ma.txt’ in the ‘Library’ directory.

6.4 Monitor Mineral κ Values

The monitor mineral κ value library is only used in the Multiple Intercalibration Tool, and
contains the following columns of information (in the specified order, from left to right): (1) the
name of the monitor mineral (this is used in the drop-down menus in the main ArAR GUI); (2)
the κ ≡ 40Ar∗/40K value of the monitor mineral; (3) the 1σ uncertainty in κ, i.e., σκ; (4) a short
reference (this is used in the drop-down menus in the main ArAR GUI); (5) the full reference from
which the monitor mineral κ value was sourced; and (6) miscellaneous notes about a particular
monitor mineral and reference. The number ‘−1’ indicates that a value was not reported by the
reference from which the data were taken. The monitor mineral κ value library is stored in the
tab-delimited text file named ‘arLib M Kappa.txt’ in the ‘Library’ directory.

7 Editing ArAR Preferences

To edit ArAR preferences, select the ‘Preferences’ item from the ‘ArAR’ menu at the top of
the main ArAR window, or use the the hotkey combination: ‘Meta + ,’, where ‘Meta’ is is
the ‘Ctrl’ key on a Windows machine and the ‘Cmd’ key on a Macintosh. The preferences
editor window will open (Fig. 25), allowing you to customize the behavior of ArAR. Preferences
are grouped into five categories: (1) general preferences; (2) import preferences; (3) export pref-
erences; (4) calculation preferences; and (5) multiple intercalibration preferences. When you are
done customizing the ArAR preferences, you can click the ‘Save Changes’ button in the lower
right corner to apply your selections. If you would like the modified preferences to be enforced
immediately, check the ‘Auto-Fill Editable Fields with Default Values’ box before clicking ‘Save
Changes.’ To restore all preferences to their defaults, delete the file named ‘ArAR Preferences.xml’
(located in the same directory as ArAR) and restart ArAR.
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Figure 25. The ArAR preferences editor window, with the ‘Calculation Preferences’ tab displayed. All
preferences are shown in their default states.

7.1 General Preferences

Under ‘General Preferences’ (Fig. 25), you can specify the ArAR working directory, which is
where ArAR looks by default when importing and exporting delimited text files. You can either
directly enter the path to the working directory, or click the ‘Browse’ button to navigate to the
desired working directory. In addition, you can have ArAR reset the working directory each time
it starts to the default user directory for your operating system. You can enable/disable: (1) the
“Getting Started” dialog box that appears on startup (it is always accessible from the Help menu);
(2) the dialog box that requests the dimensions for new datasets; and (3) the advanced JDataFrame
Editor that appears during dataset creation. Be aware that, if you disable the editor during dataset
creation, the ‘original’ states of the data are considered to be blank, so reverting edited data later
will return them to zero or null values (for numeric or notes data, respectively). Finally, you may
enable/disable the cut/copy/paste behavior where row names are copied along with other table
content in the main ArAR window and the advanced JDataFrame Editor window.
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7.2 Import and Export Preferences

By default, ArAR will automatically change its working directory to the folder containing im-
ported text file(s). You can disable this behavior in the ‘Import Preferences’ subpanel (Fig. 25) to
preserve a specific working directory. You can also choose to have all samples selected for age
recalculations upon creation/import (by default, no samples are selected). In addition, you can
select the default file type you would like to use for importing files (one of *.csv, *.txt, *.prn, or
*.jdf). If you choose JDataFrame (*.jdf) text files as the default, you can also specify what delim-
iter to use (comma, tab, space, or a custom string). This provides you with additional flexibility for
importing files with alternate delimiters. Note, custom delimiters must be alpha-numeric, and can
only include the following special characters: \ ! @ # $ % & ( ) [ ] { }. As an extreme example,
you could read files where the data are delimited by the string ‘(= Smiles =)’. Go wild!

When exporting data files, ArAR uses the working directory by default as a starting point for
the export dialogs. You can have ArAR use an alternate export path, which you can either enter
directly in the available text field in the ‘Export Preferences’ subpanel (Fig. 25), or you can click
the ‘Browse’ button to navigate to a destination directory. This allows you to have one directory
containing input files (the working directory), and a separate directory for storing recalculated data
(at the alternate export path). If desired, you can also have ArAR automatically reset the alternate
export path to the directory where you save files. (This will only occur if you enable the alternate
export path.) In analogy to the import preferences, you can select the default file type you would
like to use for exporting files (one of *.csv, *.txt, *.prn, or *.jdf), and feel free to use custom
delimiters for *.jdf files.

An important additional export preference is the ability to have the change log for each date
appended to any exported data files (it is not appended by default). If you choose this option, the
change log will be placed to the right of any of the numeric data and notes in the file. This allows
you to always have the change log associated with the recalculated dates rather than having to
manually export the change log as a separate file.

7.3 Calculation Preferences

In the ‘Calculation Preferences’ tab of the bottom subpanel (Fig. 25), you can set the default
algorithm (K-Ar or 40Ar/39Ar) and units of time (ka, Ma, or Ga) that will be selected when ArAR

launches. In addition, you can select default datasets from the ArAR libraries for the 40K decay
contants, K isotopic abundance values, and monitor mineral ages. You can also set the default
relative uncertainties to use where values are missing from these three libraries. For the 40K decay
constants library, you can select whether the automatically calculated values for λo and λ are used,
or if they must be entered manually. For monitor mineral ages, you can select whether values are
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taken from the ArAR libraries or the imported dataset. If they are taken from the library, you may
specify whether internal or external age uncertainties are used by default.

In addition to selecting default sets of constants, you can set whether external sources of uncer-
tainties are propagated into recalculated dates or not. If you choose for external uncertainties to be
propagated by default, you can also choose which sources of external uncertainties are propagated
(i.e., those related to the 40K decay constants, K isotopic abundances, and monitor mineral ages).
You can also select how uncertainties are propagated, either analytically or by a Monte Carlo ap-
proach. If you select the Monte Carlo approach, you can specify the default synthetic population
size by entering integer values or powers using the ‘∧’ character. For example, if you enter ‘2∧14’
in the text field and press ‘Enter’, the population size will be set to 214 = 16384.

Finally, you can have all recalculated uncertainties rounded automatically to the specified num-
ber of significant figures. If you select this option, rounding will be performed as if by the Round-
ing Tool, but no dialog box will be shown for setting the number of significant figures. Rather, that
value is drawn from the ArAR preferences pane.

7.4 Multiple Intercalibration Preferences

In the ‘Multiple Intercalibration Preferences’ tab of the bottom subpanel (Fig. 26), you can
select the default algorithms for the primary monitor and the form of Ri+1

i that will be selected
when the Multiple Intercalibration Tool is first launched. In addition, you can specify the default
dataset to use from the ArAR library for the 40K decay constants, and the default relative uncertainty
to use where values are missing. You may also select whether the automatically calculated values
for λ± σλ are used, or if they must be entered manually.

You may specify whether or not data for the last secondary standard are used for the sample/un-
known by default. When the (40Ar∗/39ArK) algorithm is selected for the form of Ri+1

i , you can
select whether the κ value of the primary standard is calculated from the standard age (primary
monitor algorithm: 40Ar∗/40K), and/or whether the standard age is calculated from κ (primary
monitor algorithm: exp[λt] − 1) by default. In a similar fashion, if the (exp[λt] − 1) algorithm is
selected for the form of Ri+1

i , you can specify which ArAR library will be used to auto-fill κ values
or ages for the primary monitor.

Finally, you can select whether external uncertainties from the 40K decay constants are prop-
agated by default, and whether uncertainties are propagated analytically or by a Monte Carlo ap-
proach. If you select the Monte Carlo approach, you can specify the default synthetic population
size by entering integer values or powers using the ‘∧’ character. For example, if you enter ‘2∧14’
in the text field and press ‘Enter’, the population size will be set to 214 = 16384.
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Figure 26. The ArAR preferences editor window, with the ‘Multiple Intercalibration Preferences’ tab dis-
played. All preferences are shown in their default states.
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